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Overview
Administrator Solution Tools provides a single dashboard to access multiple solutions, each
enabling OneStream administrators to perform their role effectively and efficiently. An overview of
each solution within Administrator Solution Tools is described below.

Business Rule Viewer
Allows Administrators to view current and historical business rules and member formulas. It also
provides a historical audit trail of all rules that have been added, edited or deleted.

Member Formula Builder
The Member Formula Builder lets you create and maintain dynamic and stored calculations with
step-by-step directions in a user-friendly interface that allows the user to avoid writing code. It also
provides the ability to see all formulas for a member in one place, including the scenario and time-
varying formulas.

Home Page Manager
Administrators can easily assign a default Home Page to a user or user group to display when
logging into OneStream.

Log Cleaner
Provides administrators with a simple interface to manage log files by allowing them to delete any
log type (Error, Logon or TaskLogs) in increments of 30 days up to 810 days.
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Setup and Installation
This section contains important details related to the planning, configuring, and installation of your
solution. Before you install the solution, familiarize yourself with these details.

See also: "MarketPlace Solution Modification Considerations" on page 47

Dependencies
Component Description

OneStream
6.2.0 or later

MinimumOneStream Platform version required to install this version of
Administrator Solution Tools.

Select the Administrator Solution Tools
Development Location
Before beginning installation, decide whether to build Administrator Solution Tools directly in the
Production OneStream application or in a separate Development OneStream application. This
section provides some key considerations for each option.

Production OneStream Application: The primary advantage of building Administrator Solution
Tools in a Production application is that you will not have to migrate the resulting work from a
Development application. However, there are intrinsic risks when making design changes to an
application used in a Production capacity and not advised.

NOTE: OneStream strongly recommends that you implement Administrator
Solution Tools in the Development environment with a fresh copy of the Production
application before starting work.

Development OneStream Application: As a best practice, use the Development OneStream
application to build Administrator Solution Tools.
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Create the OneStream Development
Application

1. Ensure all the OneStream artifacts relating to Administrator Solution Tools such as
workflow profiles and entities are in the production application.

2. Copy your production OneStream application to your Development environment and
rename it. This development version is used for your Administrator Solution Tools project.

Application Server Settings
You may need to edit the OneStream Application Server Configuration so users can create and
change data in the additional database tables. If other MarketPlace solutions (such as Specialty
Planning) are already in the application, these adjustments may already exist.

See also: "Solution Database Migration Advice" on page 46

Configure the OneStream Application Server
Ensure that the security group settings include the users who will be working on and setting up
Administrator Solution Tools before proceeding.

NOTE: Group settings are applicable to all MarketPlace solutions, so keep the
group names generic.

1. Start the OneStream Server Configuration Utility as an Administrator.

2. ClickOpen Application Server Configuration File > Database.

3. Edit the followingOneStream Database Server properties:

l Access Group for Ancillary Tables: Select a group that includes those who will access
records.

l Can Create Ancillary Tables: True

l Can Edit Ancillary Table Data: True

Administrator Solution Tools Guide 3

Setup and Installation



l Maintenance Group for Ancillary Tables: Select a group who will edit and maintain
tables.

l Table Creation Group for Ancillary Tables: Select a group who can create tables.

4. Restart Internet Information Server.

Install Administrator Solution Tools
1. On the OneStreamMarketPlace Dashboard, clickMarketPlace > Administrator Solution

Tools.

2. On the Administrator Solution Tools Solution page, select the appropriate OneStream
platform version from theMinimum Platform Version drop-down list.

3. Select the most recent version from the Solution Version drop-down list and then click
Download.

4. Log in to OneStream.

5. On the Application tab, click Tools > Load/Extract.

6. On the Load tab, locate the solution package using the Select File icons and clickOpen.
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7. When the solution’s file name appears, click Load.

8. Click Close to complete the installation.

Set Up Administrator Solution Tools
The first time you run Administrator Solution Tools, a guided table setup process begins.

In OneStream, clickOnePlace > Dashboards > Administrator Solution Tools >
Administrator Solution Tools.

Create Tables
1. Click Step 1: Create Tables.

This step may be necessary when upgrading even if tables are already present.
Administrator Solution Tools will not drop any tables that already exist but will modify table
structures and add any new ones if necessary.

2. When setup is complete, click Step 2: Launch Solution to open Administrator Solution
Tools.

Package Contents
The Dashboard Maintenance Unit provides the user interface for Administrator Solution Tools and
includes the required dashboard groups, components, data adapters, parameters and files.
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XFW Administrator Solution Tools
This is the Dashboard Maintenance Unit that provides the user interface for the Administrator
Solution Tools solution. It includes the Dashboard Groups, Components, Data Adapters,
Parameters, and Files used to build the solution.

Business Rules
The following business rules are included:

AST_ClearLogsForThreshold
This is an extensibility business rule for the Log Cleaner. This rule provides low impact of clearing
functions for all three major log types (Combined Error, User Logon, and Task Activity) within
OneStream.

AST_HelperQueries
This is a Dashboard Data Set business rule. This rule can look up lists of user groups and
dashboards.

AST_ParamHelper
This is a conditional parameter helper functions Dashboard XFBR String business rule. This rule
provides conditional parameter processing functions that allow a parameter value to be
interpreted and substituted with a different string.

AST_SolutionHelper
This is a Dashboard Extender business rule that provides various helper functions for the
Administrator Solution Tools solution.

AST_SolutionHelperBRV
Contains all code logic and change events for the Business Rule Viewer and Member Formula
Viewer.

AST_SolutionHelperCommon
Contains common code shared by all business rules, such as working with session state and
sorting functions.

AST_SolutionHelperHOM
Contains all code logic and change events for the Home Page Manager.

AST_SolutionHelperLCR
Contains all code logic and change events for the Log Cleaner, including functions that generate
log analysis charts.

AST_SolutionHelperMFB
Contains all code logic and change events for the Member Formula Builder.
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Settings
The Settings page contains theGlobal Options tab where you define options for
administration, member formulas and uninstalling.

Only an Administrator Solutions Tools Administrator can access the Settings page. Configure the
Administrator in Global Options, mentioned in this section and can see and make changes to any
Settings page and any solution configuration. They are referenced in this document as “AST
Solution Admin.”

Global Options
TheGlobal Options page contains key properties that guide global Administrator Solution Tools
administration. Use this page to start configuring Administrator Solution Tools.

Only an Administrator Solution Tools administrator can access the Administrator Solution Tools
Settings page. Set the Administrator inGlobal Options. The Administrator can see and make
changes to any Settings page and any solution configuration.

NOTE: Global option settings are retained during upgrades.
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NOTE: These same rights apply to any OneStream System Administrator, referred
to in this document as the “OneStream Admin.” See the Design and Reference
Guide section on Security for more information.

Security Roles
Since security is governed at the global level, it is the assignment of the user group to the Security
Role that determines who will be Administrator Solution Tools Administrators globally.

This tool kit is designed with administrators in mind. The default setting for all solutions is the
standard Administrators User Group, but this can be changed. Anyone in the Administrators User
Group is a System Administrator and, by default, can perform any of the same duties as any of the
individual solution admins. Therefore, System Administrators can always see and access all
solutions within Administrator Solution Tools.
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Manage Administrator Solution Tools
Anyone assigned to this User Group is considered a super-user who can configure any aspect of
Administrator Solution Tools and are referred to as the Solution Administrator. This user will have
access to the Settings page to manage security set up for all tools within Administrator Solution
Tools. This user will not have access to any of the individual solutions unless they are part of that
solution’s access group.

Example: The Administrator Solution Tools administrator may have access toManage
Administrator Solution Tools however they do not have access to Access Home Page
Manager. This was done to allow Administrators to hide unwanted solutions from their
Administrator Solution Tools Home Page. If allowing Administrator access to all Administrator
Solution Tools is desired, create an Administrator Solution Tool Administrator security group
located in System > Security > System Security Roles, and add each solution’s security
access to the Group Membership.

Access Administrator Solution Tools
This group can access the Administrator Solution Tools Home page. This security group
supersedes any of the ensuing security groups. Therefore, any user who needs to access
individual solutions within AST and is part of one, or many, of the groups below, must also be
included in this security group first to gain access.

Access Home Page Manager
This group can access the Home Page Manager solution and assign home pages to users. The
Administrator role is required to access and use the Home Page Manager solution. This includes
any user included in the Administrators User Group.

Access Business Rule Viewer
This group can access the Business Rule Viewer and can view Business Rules or Member
Formulas. The Administrator role is required to access and use the Business Rule Viewer. The
Administrator role includes any user included in the Administrators User Group.

Access Log Cleaner
This group can access the Log Cleaner solution and execute the clear logs process.

Access Member Formula Builder
This group can access the Member Formula Builder.

Creating formulas is a metadata change. Inherently, belonging to this access group does not
inherently allow users to change metadata, such as the Formula property on an Account. Users in
this group must also be included in the ManageMetadata security role, found under Application>
Security Roles. Giving access to manage metadata has other system implications. Therefore it is
recommended to limit the number of uses within this access group:
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If this User Group is not included in the group forManageMetadata, select the dimension in
Dimension Library where edits are desired, select the Dimension Properties tab and ensure that
this group is included in theMaintenance Group for that individual dimension.
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Member Formula Builder Settings
Preview Non-Member Formula Builder Formula
The Preview Non- Member Formula Builder Formula check box is enabled by default, allowing
a user to see the formula and drill down tabs that indicate a member formula was created outside
of Member Formula Builder.

NOTE: This interface is read-only. You can enter data on the page, but it is not
save. Edit formulas in the Dimension Library.

See also: TheMember Formulas section in the Foundation Guides chapter of the Design and
Reference Guide.

If the Preview Non-Member Formula Builder Formulas check box in the Administrator Solution
Tools Global Settings is cleared, the formula and drill-down tabs do not display. Edit formulas in
the Dimension Library.
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Uninstall
The Uninstall feature allows the Administrator Solution Tools User Interface or the entire solution
to be uninstalled. Note that if part of an upgrade, any modifications performed on standard
Administrator Solution Tools objects will be removed. There are two Uninstall options:

l Uninstall UI removes Administrator Solution Tools, including related dashboards and
business rules but leaves the database and related tables in place. For some releases, this
step should be performed before accepting any new version of Administrator Solution Tools
since some of the Dashboards or other objects may have been modified.

Choose this option to update without removing the data tables. Check the Release Notes to
see if an overinstall is supported.

l Uninstall Full removes all the related data tables, all data, Administrator Solution Tools
Dashboards, and Business Rules.

Choose this option to remove Administrator Solution Tools or to perform an upgrade that is
so significant in its changes to the data tables that this method is required.

CAUTION: Uninstall procedures are irreversible
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Administrator Solution Tools
Dashboard
Access the Administrator Solution Tools dashboard by clickingOnePlace > Dashboards >
Administrator Solution Tools. Starting Administrator Solution Tools opens the Home page. The
icons that display are based on security roles specified inGlobal Options. Use this page to use
the Administrator Solution tools that you have permission to access. To return to the Home page,
select the Show Home Page icon in the top toolbar.
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View Business Rules and Member
Formulas

The Business Rule Viewer lets you view any business rule or member formula created in
OneStream.To launch the Business Rule Viewer, click the Business Rule Viewer icon on
the Administrator Solution Tools Home page.

Business Rules
A business rule is a VB.Net class that performs a function or set of functions in OneStream. Each
business rule is an independent object encapsulating VB.Net code. Business rules are created
using the Business Rule Editor in Application Tools. Any business rule created in OneStream can
be viewed in the Business Rule Viewer.

See also:

l The Business Rules section in the Foundation Guides chapter of the Design and Reference
Guide for information on business rule fundamentals, organization, framework, and other
details.

l The Business Rules section in the Application Tools chapter of the Design and Reference
Guide for details on using OneStream to design Business Rules.

l TheOneStream API Overview Guide,OneStream API Details, and database
documentation fromMarketPlace for business rule engine details.

Member Formulas
Amember formula is assigned to a dimension members and runs in the Finance Engine during
cube processing.

Member formulas are created directly on a member in the Dimension Library or with the
Administration Solution Tools Member Formula Builder. Member formulas created in the Formula
Editor in the Dimension Library must be edited in the Dimension Library.

See also:
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l Build Simple Member Formulas in OneStream

l TheMember Formulas section of the Foundation Guides chapter of the Design and
Reference Guide for information on Member Formula fundamentals and using OneStream
to design Member Formulas.

Select a Business Rule or Member Formula
to View
The Business Rule Viewer lets you view business rules or member formulas side-by-side. It's
most useful for viewing two versions of the same business rule, member formula, or similar rules
or formulas.

Use the drop-down lists in the Business Rule Viewer's Business Rules and Member Formulas
pages to select the rules or formulas to view. The drop-downs lists are filters to help organize and
quickly search. Selecting a value in a drop-down list filter determines the available values in the
next drop-down list. For example, if you are searching for a member formula to view and select
Flow as the dimension type, only the dimensions belonging to Flow display in the Dimensions
drop-down lists.

The following shows the Business Rule Viewer drop-down list boxes for business rules and
member formulas.

The left and right areas are connected, so when you select a value on the left, the Business Rule
Viewer automatically populates the same field on the right with the same value.

See also: Connected and Disconnected Viewing Panes for more information on how the viewing
area works.

When you select a value forModified Date (UTC) on the left, the Business Rule Viewer displays
the rule or formula you want to view in the left textbox. It also selects and displays the next most
recent version (if one exists) in the right text box. If the next most recent version of the rule of
formula shows as deleted, the next most recent version displays on the right. The Business Rule
Viewer assumes that you want to view a selected rule's most recent version and the next most
recent version in the side-by-side viewing areas.
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NOTE: If a business rule or member formula does not have an earlier version, No
previous business rule to display is dipslayed in the viewing area.

Connected and Disconnected Viewing Panes
When you select a business rule or formula to view, the left side shows the selected version and
the right side shows the next most recent version. The views are connected, so the left and right
side scroll together.

If you change a drop-down list value on either side, the sides are no longer connected and work
independently. When the left and right sides are disconnected, you can use the filters
independently to view different business rules or member formulas.

NOTE: The sides scroll together even when viewing different business rules or
formulas.

The following image shows different business rules displayed in the left and right views of the
Business Rule Viewer.
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Click Reset Filters to reconnect the left and right views. This clears the drop-down filters on both
sides, initiating the connection of the left and right views.

View a Business Rule
1. In the Business Rule Type drop-down list to the left, select the type of the business rule to

view.

2. In the left Business Rule drop-down, select the business rule to view. Only rules belonging
to the specified rule type display..

3. In Modified Date (UTC), select the version of the business rule to view.

NOTE: Business rules that are encrypted include the text (encrypted) in the
Modified Date (UTC) value. Encrypted business rules do not display in the
Business Rule Viewer. When you select an encrypted business rule, the text
Selected business rule is encrypted displays in the viewing area.

See also: Business Rule Encryption (Decryption) in the Application Tools section
of the  Design and Reference Guide for more information.

In the following example, the most recent version of the AST_SolutionHelperBRV business Rrle
displays on the left, with the next most recent version of the same rule on the right.
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The left and right sides are connected and scroll together, making it easy to view them.

View Business Rule XML 
By default, business rules do not show the XML code at the beginning and end of the rule. You
can display the XML code for selected rules by clicking Show XML in the desired view. The
Business Rule Viewer keeps the displayed rules connected if you show the XML code.
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Access the Business Rule Source
When viewing business rules, you may want to make edits to the rule itself. To do this, click Show
Business Rule Page . The Business Rule page displays in a separate tab. Use CTRL + A to
highlight the rule to copy and paste, then navigate to the business rule you want to edit.

See also: Business Rules in the Application Tools chapter of the Design and Reference Guide.

View a Member Formula
Use the Member Formula viewer to view all member formulas.

To view a formula in the Member Formula Viewer, filter using the drop-down list to the left find
formulas.

IMPORTANT: You can only access the Member Formula Viewer from the Business
Rule Viewer.
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1. To access the Member Formula Viewer click Show Member Formula Viewer Page .

2. In Dimension Type, make selections from these options for the member formula you want to
view:

l Dimension Type: Select the dimension type for the member whose member formula
you want to view.

Dimension Types are used to group dimensions and includes User-Defined
dimensions. Only Dimension Types used display in the list.

l Dimension: Select the Dimension containing the member whose formula you want
to view. Only dimensions belonging to the specified Dimension Type display in the
list.

l Member: Select the member of the Member Formula you want to view.

l Scenario Type: Select the Scenario Type associated with the member formula you
want to view. Select Default Scenario if the Member Formula applies to all scenario
types. A scenario type can contain multiple scenarios.

l Time: This list contains the Time Profile for the selected Scenario Type. Select the
Time for the Scenario Type containing the Member Formula you want to view.

l Modified Date (UTC): Select the version of the Member Formula you want to view.

The left and right sides are still connected, so the left and right sides scroll together, making it
easy to compare them.

Access the Member Formula Source
When viewing member information, you can edit the member formula.
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You can access the Dimension Library while working in the Member Formula Viewer. Copy the
text using CTRL + A then click the Show Dimension Library Page button. The Dimension
Library displays in a separate tab, and displays the most recently accessed member properties. In
the Members tab of the Dimension Library, navigate to the member formula to edit.

See Also:Member Formulas in the Foundation Guides chapter of the Design and Reference
Guide.

View a Single Business Rule or Member
Formula
The text box sizes for the side-by-side view in the Business Rule viewer may cause lines in a
business rule or formula to display on two or more lines, making it difficult to read. Click Show
Fullscreen to resolve this issue.
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Toggling between Fullscreen view and the standard view does not disconnect the left and right
side filter values. For example, if you reset the filter values and then switch back to the standard
view, the left and right sides scroll together.

Copy a Business Rule or Member Formula
You can copy any text in the left or right view. This is useful when you want to edit or replace a
business rule or member formula. Select the text, and then CTRL+C to copy. To select the entire
rule use CTRL+A.
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Viewing Business Rule and Member
Formula Change Histories

Use the Business Rule Viewer - Historical Viewer to determine when business rule or
formulas were updated. From the Business Rule Viewer, click Show History Page to
display the viewer and access the change histories.

Clicking the Show History Page icon while viewing business rules displays the Business Rule
history. Click Show History Page while viewing formulas to display their history. Historical data
displays in a grid, allowing you to group records using the grid capabilities.

1. From View, select Business Rules or Member Formulas.

2. In the Date Range field, select the number of days from today to display historical records.
For example, to display the last 30 days of changes, select 30 from the list.

TIP: The records listed in the grid change based on your selections.

Administrator Solution Tools Guide 24

View Business Rules and Member Formulas



3. To view a business rule or member formula, select it in the grid and click the View button.
This lets you access details in the appropriate viewer.
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Build Simple Member Formulas
The Member Formula Builder lets you create basic member formulas. If you need a
complex formula, create it in the Dimension Library.

See also: TheMember Formulas section in the Foundation Guides chapter of the Design and
Reference Guide .

To launch Member Formula Builder, clickMember Formula Builder on the Administrator
Solution Tools Home page.

Before building a member formula, ensure the member exists and the Formula Type, either stored
or dynamic, is established in the member's properties settings. To select the formula type, click
Application> Dimensions, select the member, selectMember Properties, and then select the
formula type in Settings.

Use FormulaPass1 – FormulaPass16 for stored formulas. Use DynamicCalc and
DynamicCalcTextInput for dynamic formulas.
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Formula Build Process
Perform these steps to build a member formula:

l Select the dimension, member, and account you want to create the member formula.

l Select Scenario Type and Time properties.

l Build the formula and add calculation filters.

Select the Member
Select the dimension from the drop-down and then select the member.

TIP: To access a known member, use the search bar at the top of the Select Member
pane to find the member or you can navigate through the hierarchy to find the
appropriate member.

After you select a dimension, member, and account member for your formula, the other panes of
the Member Formula Builder appear and you can continue the formula build process.

Select Properties
In the Select Properties pane, the Formula Type and Account Type labels show the formula or
account type assigned to a selected member. The Existing Formulas drop-down list shows
Scenario: (Default)|Time Period: (Default) and displays other existing formulas on a selected
member. If you select the default Scenario and Time formula, the Scenario Type and Time display
as (Default Scenario Type) and (Default Time) respectively.
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Select the scenario and time to apply to the formula.

If there is already a formula associated with the member, you can preview the formula before
making any changes. Click Preview to display the existing formula.

You cannot edit a formula if it was created outside of the Member Formula Builder. Users with the
Administrator role can edit formulas created outside of the Member Formula Builder in the
Dimension Library. Click Dimension Library to go to Member Properties, where you can edit the
formula.
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Build the Formula
Use the Build Formula section to create a simple member formula.

Dimension Icons
When you select a dimension icon, the Select Member dialog box appears so you can select the
appropriate member from the hierarchy.
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Time Variables
These are sample Time Functions that can be used to create a formula and were included for
ease of formula creation. Items selected from this dropdown are added to the Expression. For
more information on Time Functions, see the Design and Reference Guide.

Criteria
Defines the dimension to which the formula is applicable. If a criteria is selected from the
dropdown, it does not show in the Member Formula text box but can be seen in the Preview
dialog box.

Expression
This text box shows the selected dimensions or time functions selected. For stored formulas, the
expression automatically populates for the member selected in the Select Member pane to help
start the stored formula creation. Any text that is entered here can be cleared using the Clear
button.

Clear
The Clear button is used to clear the Expression text box.
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Add
There are left and right Add buttons which determine whether to place the expression before or
after the Member Formula. Click the appropriate Add button to add the content currently in the
Expression text box to the specified place in theMember Formula.

Calculation Filters
Only appears for stored formulas. This option lets you build calculation filters based on
dimensions. Selecting this check box displays the Add Calculation Filters pane that lets you add
filters that are calculated only if certain criteria are met.

To add a calculation filter:

1. Under Build Formula, select the Calculation Filters check box to open the Add
Calculation Filters pane.

2. In the Add Calculation Filters pane, click on the desired dimension button. The Select
Member dialog box displays.

3. Use navigation in the Hierarchy and Search tabs to select a member to which the
calculation filter applies.

TIP: You can use the Select Member dialog box to select multiple members to which
the calculation filter applies.

4. ClickOK to close the Select Member dialog box and return to the Add Calculation Filters
pane. Selected members are added to the calculation filter.

5. Select the expansion from the drop-down next to the selected dimension.
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In the previous example, the formula first runs on the UD1 base members under the
U1#Mfg.Base dimension. The calculation filter is added by selecting the U1# icon, then selecting
the member from the Select Member dialog. The appropriate expansion is added by selecting
from the drop-down.

Criteria defined in the text boxes are automatically saved and are part of the formula creation. You
can see the calculation filters as part of your formula by clicking Preview.
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Comments
Use this to include a description for the formula. When you preview the formula, you can also
review the comments.

Include Drilldown
Selecting this check box allows drilldowns on the field for which the formula is being created. This
also allows you to edit the drilldown formula, which displays in the Drilldown Formula tab of the
Formula Preview.

RemoveZeros()
The RemoveZeros() function can be used to evaluate a source data buffer and remove all zeros in
cells where the amount is zero whether or not it is flagged as a NoData cell. This function is
important to use for performance purposes and therefore is enabled by default.
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See also: The Design and Reference Guide for more information on the RemoveZeros() function.

Add Formula Complexity
You can use the Formula Editor to add complexity to a formula originally created in Member
Formula Builder outside of the solution (such as creating multi-line rules). We recommend that
you remove the Member Formula Builder syntax from business rule. This prevents formula
creators from viewing and updating complex rules in the Member Formula Builder.

NOTE: After building a formula, return to the Dimension Library and click Compile
on the Formula Editor’s toolbar to ensure that the VB.NET syntax is correct.
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Manage Home Pages for Users
The Home Page Manager page allows Administrators to assign users or user groups to
a default Home Page that displays when you log into OneStream. To launch Home Page
Manager, select the icon on the Adminstrator Solution Tools home page.

The Home Page Manager lets you assign a default page to any user or user group. By default,
only users in the Administrators User Group can access the Home Page Manager, and only
Administrators can change this setting.

See also: The Access Home Page Manager setting in Settings for more information.

Users and User Groups are part of system security and are defined in OneStream.

See also: System Security Users and Groups in the System Administration chapter of the
OneStream Design and Reference Guide for more information about creating users and user
groups.

The Home Page Manager includes the following:

l A User/User Groups pane where you indicate if you are making an assignment for a single
user or all users belonging to a specified user group.

l The Select Home Page pane, where you select the home page and assign it to the user or
user group.

l The Home Page Viewer pane shows the currently assigned home page for a user (if any) in
the Current tab, and a Preview tab that displays the currently selected home page. You
can easily switch between these tabs to see current user home page assignments and
preview other home pages to assign.
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Assign a Home Page
1. Use the radio buttons on the upper left pane to set whether the home page assignment is

for a user or a user group.

If a user already has a home page assigned, the Current tab in the Home Page Viewer
pane shows the page assigned to the user. For both Users and User Groups, if a home
page has been previously assigned, use the Clear button to unassign the current home
page. See Change a Home Page Assignment.

2. In the Select Home Page pane, select the home page you want to assign from the list. The
selected home page displays in the Home Page Viewer pane's Preview tab.

3. Click Set to assign the home page to the selected user or user group. A message indicates
that the Home Page setting was updated. For user groups, the message also includes the
number of users in the group and information about any errors during processing. See
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Respond to Processing Errors.

TIP: The User/User Group Selection and Select Home Page panes include a filter
that you can use to search for users, user groups, and home pages.

Change a Home Page Assignment
1. Select the user or user group whose home page assignment you want to change. The

currently assigned home page displays in the Current tab of the Home Page Viewer pane.

2. Click Clear to clear the current home page assignment for the selected user.

3. Use the Select Home Page pane to navigate to the home page you want to assign, and
then click Set.

Assigning a Home Page: Example
Below is an example of how to set up Homepage Manager for a group or individual users.

NOTE: Your application may have different groups and dashboards since this is
based on our example application.

1. Click User.

2. Type HDK in the first Text Filter search box for the user group/user selection to find all users
with HDK in the name. Click on the HDK_Admin user to select it.

3. Enter HDK in the Home Page Text Filter search box to find the dashboards with HDK in the
name. Select 2a_TicketAnalysis_HDKA.
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4. The selected dashboard displays in the Preview pane and shows a sample of the selected
dashboard.

5. Click Set to save the selections for the user HDK_Admin.

For this example, the Set Home Page results displays as shown in the following image.

6. Log in as HDK_Admin to confirm that the user can access the selected dashboard.
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Respond to Processing Errors
The Set Home Page Resultsmessage provides error information when an Administrator tries to
assign a dashboard to users who do not have access to the dashboard. Home Page Manager
processes the changes that are valid and notes those that could not be processed in Set Home
Page Results. Home Page Manager provides additional details for any other assignment errors
in the error log for review and resolution.

NOTE:When selecting a preview in Home Page Manager and using Internet
Explorer, solutions that contain multiple embedded dashboards may not display.
This issue only occurs in the OneStream browser version.
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Clean Unneeded Log Entries
To launch Log Cleaner, click Log Cleaner on the Administrator Solution Tools home
page.

Use the Log Cleaner to delete user log entries, error log entries or task activity log entries. The
Access Log Cleaner setting in the Global Options determines which users can access this feature.

See also: The security roles section in Settings for more information on the Access Log Cleaner
setting.

Perform these steps to delete logs:

l Select the type of logs you want to clear.

l Select the application and user for which you want to delete log records.

l Select the number of days from today you want log records to be retained.

l Select Execute to clear selected logs.

Select Log Types to Clear
The first step to clear log files is to select the types of logs to be cleared. Use the fields in the
Types to Clear section of Log Cleaner to do this. Select values from the following:

NOTE: All fields in this section are set to No by default.

User Logon Activity
Set to Yes to clear records of all users when they log on and off OneStream applications. These
records show who is logged on and when they log off for all applications.

Error Logs
Set to Yes to clear any logs from error processes, including errors written from business rules.

Task Activity Logs
Set to Yes to clear logs for all running and completed tasks.
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When you change any of the default settings in the Types to Clear section, the Execute Clear
Logs Data Management Sequence section of the Log Cleaner appears. Click Execute to clear
logs based on the selected criteria.

Select Application and/or User
The second step in the log clearing process is to select specific users and applications whose log
entries you want cleared.

Log Cleaner allows administrators to select custom filtering to clear the Error Log based on
specific text.

Use the fields to clear logs based on application, user, and text in the log.

Application
Clear logs for a specific application or all applications.

User
Clear logs for an individual user or all users in the environment.

Error Description Contains (optional)
Enter a text string from a log error to clear logs that use the string. The string must match exactly.
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Select Days to Retain
The third step in the log cleaning process is to determine how many days of error logs should be
retained after the current log clearing executes.

Days to Retain
Use this field to set the number of days error logs are retained after the current log clearing
executes.

Select a value between 30 and 810 days. For example, if set to 90, all qualified error records older
than 90 days are cleared.

Execute Clear Logs Data Management
To clear logs, select log clearing criteria and the number of days to retain log records, and then
click Execute.

The Log Cleaner displays cleaning tasks as they execute. If needed, click Cancel Task to stop
the log clean process. Click Close when cleaning completes.
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Log Analysis Page
The Log Analysis page provides a graphical user interface to review OneStream logs. The page
includes the following tabs that provide details on OneStream logs

Log Size
This tab shows the size of each log table by type (in megabytes) in a pie chart. Log types that
display are:

l Task Activity

l Error Log

l Logon Activity

l Logs from all other tables

Use the information to help determine which logs you want to clear. In the following graphic, the
All Other Tables log table contains the bulk of retained log entries, representing a potential place
to focus a log clearing process.
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Logs by User
This tab contains a bar chart showing the users with the most retained log activity. Bars on the
chart are color-coded, so you can see details on the exact number of task activity, error log, and
logon records for each user. Use this chart to quickly see which users you may want to focus on
for your log clearing process.

Logs by Application
This tab contains a bar chart showing log entries by log type for each application. Bars on the
chart are color-coded, so you can see details on the exact number of task activity, error log, and
logon records for each application. Use this chart to see the applications you may want to focus on
for your log clearing process.

Logs by Date
This tab contains a bar chart showing the number of log entries by log type based on the amount
of time the records have been retained. Bars on the chart are color-coded, so you can see details
on the exact number of task activity, error log, and logon records for each.

Use the dropdown to select a monthly, quarterly, semi-annual, or whole year retention period. Use
this chart to see retention periods with the most log entries of each type.
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Help and Miscellaneous
Information
Display Settings
OneStream and MarketPlace solutions frequently display multiple data elements for proper data
entry and analysis. We recommend you set your screen resolution to 1920 x 1080 to best render
forms and reports. Also, adjust the Windows System Display Text setting to 100% and do not
apply custom scaling options.

Package Contents & Naming Conventions
The package file name contains multiple identifiers that correspond with the platform. Renaming
any of the elements contained in a package is discouraged in order to preserve the integrity of the
naming conventions.

Example Package Name: AST_PV6.2.0_SV101_PackageContents.zip

Identifier Description

AST Solution ID

PV6.2.0 Minimum Platform version required to run solution

SV101 Solution version

PackageContents File name
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Solution Database Migration Advice
A development OneStream application is the safest method for building out a solution with custom
tables such as this one. The relationship between OneStream objects such as workflow profiles
and custom solution tables is that they point to the underlying identifier numbers and not the
object names as seen in the user interface. Prior to the solution configuration and to ensure the
identifiers match within the development and production applications, the development
application should be a recent copy of the production application. After the development
application is created, install the solution and begin design. The following process below will help
migrate the solution tables properly.

See also:Managing a OneStream Environment in the Design and Reference Guide.

1. In the production OneStream application, install the solution and create the data tables.
See Configure the OneStream Application Server for Database Server Connection settings
and installation details.

2. Data tables are created in the OneStream Development application during the solution
installation. Using the Microsoft Data Migration Assistant, copy the data from the tables to
the Production Microsoft SQL Server Database. Only the Microsoft SQL Administrator
should run the migration assistant.

IMPORTANT: This process may overwrite existing table data in the production
application database if data already exists.
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MarketPlace Solution Modification
Considerations
A few cautions and considerations regarding modification of MarketPlace solutions:

l Major changes to business rules or custom tables within a MarketPlace solution will not be
supported through normal channels as the resulting solution is significantly different from
the core solution.

l If changes are made to any dashboard object or business rule, consider renaming it or
copying it to a new object first. This is important because if there is an upgrade to the
MarketPlace solution in the future and the customer applies the upgrade, this will overlay
and wipe out the changes. This also applies when updating any of the standard reports and
dashboards.

l If modifications are made to a MarketPlace solution, upgrading to later versions will be more
complex depending on the degree of customization. Simple changes such as changing a
logo or colors on a dashboard do not impact upgrades significantly. Making changes to the
custom database tables and business rules, which should be avoided, will make an
upgrade even more complicated.
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